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1 Avant-propos

1.1 BluelJ

Ce tutoriel est une introduction a l'utilisation de l’environnement de programmation
BLUEJ. BLUEJ est un environnement de développement Java(tm) destiné a 1’enseignement
initial & la programmation. Il a été concu et développé par ’équipe BLUEJ de 'université
Monash a Melbourne, en Australie, et I'université de Southern Denmark, Odense.

Vous trouverez plus d’information sur BLUEJ a ’adresse http://www.bluej.org.

1.2 But et public visé

Ce tutoriel est destiné aux utilisateurs qui veulent se familiariser avec I’environnement.
Il ne contient ni d’explications sur la conception de ’environnement ni sur les recherches
en amont.

Ce tutoriel n’a pas pour but 'apprentissage de Java. Il est conseillé aux débutants de
consulter un livre d’introduction a Java ou de suivre un cours de Java.

Ce document n’est pas non plus un manuel de référence exhaustif sur I’environnement.
Beaucoup de détails sont omis — ’accent est mis sur la brieveté et la concision plutot que
sur l'analyse complete des fonctionnalités.

Chaque section commence par un résumé qui permettra aux lecteurs qui sont déja
familiers avec certaines parties du systeme de décider de 'opportunité de lire ou de sauter
une partie. La section 10 ne fait que répéter ces résumés et fait office d’index du document.

1.3 Copyright, droit de licence et de distribution

Le systeme BLUEJ et ce tutoriel sont disponibles en acces a toute personne et pour
tout type d’utilisation. Le systeme et sa documentation peuvent étre distribués librement.

Aucune partie de BLUEJ ou de sa documentation ne peut étre commercialisée ou incluse
dans un paquetage commercialisé sans ’autorisation des auteurs.

Le droit de copyright (©) est détenu par M. Kolling and J. Rosenberg.

La traduction francaise a été réalisée par le groupe sigma (http://www.enseeiht.fr/
lima/sigma).

1.4 Réactions

Les commentaires, questions, corrections, critiques ou toute autre forme de réactions
concernant BLUEJ ou ce tutoriel sont bienvenus et encouragés. Contacter Michael Kolling
(mik@mip.sdu.dk) ou le groupe Sigma bluej@enseeiht.fr pour la traduction en francais.


http://www.bluej.org
http://www.enseeiht.fr/lima/sigma
http://www.enseeiht.fr/lima/sigma
mik@mip.sdu.dk
bluej@enseeiht.fr
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2 Installation

BLUEJ est distribué sous trois formats différents : pour Windows, pour MacOS et pour
les autres systemes. La procédure d’installation est assez simple.

Prérequis

Vous devez disposer de J2SE v1.3 (i.e. JDK 1.3) ou supérieur installé sur votre systeme
avant d’utiliser BLUEJ. Si vous n’avez pas un JDK installé vous pouvez en télécharger un a
partir du site de Sun a l'adresse http://java.sun.com/j2s€. Sur MacOS X, une version
récente est pré-installée — vous n’avez pas besoin d’en installer une vous-méme. Si vous
trouvez une page proposant un « JRE » (Java Runtime Environment) et un « SDK »
(Software Development Kit), vous devez télécharger le SDK — le JRE ne suffit pas.

2.1 Installation sous Windows

Le fichier de distribution pour les systemes Windows s’appelle bluejsetup-xxx.exe,
ou xxx représente le numéro de version. Par exemple, la distribution BLUEJ version 1.2.0
est contenue dans un fichier nommé bluejsetup-120.exe. Vous pouvez trouver ce fichier
sur un CD ou vous pouvez le télécharger a partir du site BLUEJ a 'adresse http://www.
bluej.org.

Exécutez ce fichier d’installation. L’exécutable vous permet de choisir un répertoire
d’installation. Vous avez aussi la possibilité d’installer un raccourci dans le menu de
démarrage et sur le bureau.

Une fois I'installation terminée, le programme bluej.exe se trouve dans le répertoire
d’installation de BLUEJ.

Lors du premier lancement, BLUEJ recherche un JDK sur le systéeme. Si plus d'un
systeme Java est trouvé (par exemple, vous avez le JDK 1.3.1 et le JDK 1.4 installés), une
boite de dialogue vous permettra d’en choisir un. Si aucun JDK n’est trouvé, il vous sera
demandé de le localiser vous-méme (cela peut arriver dans le cas ot un JDK est installé
mais les entrées correspondantes dans la base de registres ont été supprimées).

Le logiciel d’installation BLUEJ installe aussi un programme appelé vmselect.exe.
Celui-ci vous permettra de modifier ultérieurement la version Java utilisée par BLUEJ.
Exécuter vmselect pour faire démarrer BLUEJ avec une version différente de Java.

Le choix du JDK est stocké pour chaque version BLUEJ. Si vous avez plusieurs versions
de BLUEJ installées, il est possible d’utiliser une version de BLUEJ avec le JDK 1.3.1
et une autre avec le JDK 1.4. Le changement de version Java pour BLUEJ changera la
configuration de toutes les installations de la méme version BLUEJ pour le méme utilisateur.

2.2 Installation sous Macintosh

Veuillez remarquer que BLUEJ tourne sous MacOS X seulement.
Le fichier de la distribution pour MacOS s’appelle BlueJ-xxx.sit, ol xxx est un
numéro de version. Par exemple, la distribution BLUEJ version 1.2.0 s’appelle BlueJ-120.sit.


http://java.sun.com/j2se
http://www.bluej.org
http://www.bluej.org
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Vous trouverez ce fichier sur un CD ou vous pourrez le télécharger a partir de http:
//www.bluej.org.

Ce fichier peut étre décompressé avec Stufflt Expander, et beaucoup de navigateurs le
feront pour vous. Sinon vous pouvez le décompresser en double-cliquant sur le fichier dans
le Finder.

Apres la décompression, vous aurez un répertoire appelé BlueJ-xxx. Déplacez-le dans
votre répertoire Applications (ou & n’importe quel endroit de votre choix). Il n’y a rien
d’autre a faire pour l'installation.

2.3 Installation sous Linux/Unix et autres systémes

Le fichier d’installation est un fichier jar exécutable. Son nom est bluej-xxx.jar, ou
xxx est le numéro de version. Par exemple, la distribution BLUEJ version 1.2.0 est contenue
dans un fichier nommé bluej-120. jar. Vous pouvez trouver ce fichier sur votre disque ou
vous pouvez le télécharger a partir du site BLUEJ a ’adresse http://www.bluej.org.

Lancez l'installation en exécutant la commande suivante :
<jdk-path>/bin/java -jar bluej-120.jar
ou <jdk-path> est le répertoire ou le JDK est installé.

NB : Pour cet exemple, la distribution bluej-120.jar est utilisée. Vous
devez indiquer le nom du fichier correspondant a votre distribution (avec le
bon numéro de version).

Une fenétre apparait et vous permet de choisir le répertoire d’installation de BLUEJ
ainsi que la version de JDK pour exécuter BLUEJ. Important : le chemin d’acces vers
BLUEJ (y compris les répertoires parents) ne doit pas contenir d’espaces.

Appuyez sur m pour finir 'installation.

2.4 Problemes d’installation

Si vous avez des problémes, consultez d’abord les foires aux questions (FAQ) sur le site
BLUEJ (http://www.bluej.org/help/faq.html) et lisez la section How To Ask For Help
(http://www.bluej.org/help/ask-help.html).


http://www.bluej.org
http://www.bluej.org
http://www.bluej.org
http://www.bluej.org/help/faq.html
http://www.bluej.org/help/ask-help.html
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3 Pour débuter — édition / compilation / exécution

3.1 Lancement de BluedJ

Sous Windows et MacOS, un programme nommé BluelJ est installé. Lancez-le. Sous les
systemes Unix, le programme d’installation place un script nommé bluej dans le répertoire
d’installation. A partir d’une interface graphique, le lancement s’opere par un double clic
sur le nom du fichier. Depuis une ligne de commande, vous pouvez lancer BLUEJ avec ou
sans nom de projet en argument :
$ bluej
ou
$ bluej examples/people

3.2 Ouverture d’un projet

Résumé :  Pour ouvrir un projet, sélectionner Open dans le menu Project.

Les projets BLUEJ, comme les paquetages Java standard, sont des répertoires contenant
les fichiers associés.

Apres avoir lancé BLUEJ, utilisez la commande Project > Open pour choisir et ouvrir
un projet.

Quelques exemples de projets sont proposés dans le répertoire examples de la distri-
bution standard de BLUEJ.

Pour cette partie du tutoriel, ouvrez le projet people qui est inclus dans ce répertoire.
Vous pourrez trouver le répertoire examples dans le répertoire principal de BLUEJ. Apres
avoir ouvert le projet vous devez obtenir une fenétre semblable a celle de la figure [Il. La
fenétre peut ne pas étre exactement la meéme selon votre systéeme, mais les différences seront
mineures.

3.3 Création d’objets

Résumé :  Pour créer un objet, sélectionner un constructeur dans le menu contextuel
de la classe.

Une des caractéristiques fondamentales de BLUEJ est que, en plus de I'exécution d’ap-
plications completes, vous pouvez également interargir directement avec des objets de n’im-
porte quelle classe et exécuter leurs méthodes publiques. Une exécution sous BLUEJ est sou-
vent faite en créant un objet puis en invoquant une de ses méthodes. Ceci est extrémement
utile pendant la phase de développement d’une application — vous pouvez tester les classes
une par une des qu’elles ont été écrites. Il n’est donc pas nécessaire de commencer par
écrire toute 'application.

NB : Les méthodes statiques peuvent étre exécutées directement sans avoir
besoin de commencer par créer un objet. La méthode main des applica-
tions Java est statique, il est donc possible de lancer une application sim-
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8ee Blue): people

Project Edit Tools View Help

— | | Database

———
Pp—— [ sw—
Compile

View

E Uses ﬂ

E Inheritance
-

Creatinﬁ nb‘lect... Done A

F1G. 1 — La fenétre principale de BLUEJ
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8006 Bluel: people
Project Edit Tools View Help
' Mew Class |
s | é Database
| _[:"‘ |
1
f compile |
et ! c<abstract>:
Lommmes =| Person
View Staff Student
E Uses new Staffiname, yearOfBirth, roomNumber)
E Inheritance
- Open Editor
i Compile
| Remove

F1a. 2 — Opérations sur les Classes (menu contextuel)

plement en exécutant sa méthode main. Nous reviendrons sur cet aspect
ultérieurement. Mais d’abord nous allons faire quelques petites choses plus
intéressantes, qu’on ne peut pas faire dans d’autres environnements Java.

Les rectangles que vous voyez dans la partie centrale de la fenétre principale (étiquetés
Database, Person, Staff et Student) sont des icones représentant les classes impliquées
dans cette application. Vous pouvez obtenir un menu avec les méthodes applicables a
chaque classe en cliquant sur l'icone de la classe avec le bouton droit de la sourisf(figure
). Les opérations présentées sont les nouvelles opérations associées a chaque constructeur
défini pour cette classe immédiatement suivies par d’éventuelles opérations fournies par
I’environnement.

Pour créer un objet Staff, il faut cliquer avec le bouton droit sur l'icone Staff (ce qui fait
apparaitre le menu de la figure B). Le menu indique deux constructeurs pour créer un objet
Staff, 'un avec parametre et ’autre sans. Sélectionnez pour commencer le constructeur

2Chaque fois que nous mentionnons un clic droit, les utilisateurs de Macintosh doivent lire Ctrl-clic.
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e 0 Blue): Create Object

/f Create a staff member with default settings for detail information.

Staff()

Mame of Instance: | staff_1

€ ok ) cancel

A

F1G. 3 — Création d'un objet (constructeur sans parametre)

@ Uses I d

@ Inheritance

Creatini c:nb'Iect... Done

F1G. 4 — Un objet dans le présentoir a objets.

sans parametre. Le dialogue indiqué figure B apparait alors.

Un nom d’objet est demandé dans la fenétre de dialogue. Un nom par défaut (staff_1)
est proposé. Ce nom par défaut suffit dans le cas présent, donc cliquez . Un objet
Staff est alors créé. Une fois 1'objet créé, il est placé sur le présentoir a objets (figure [).
La création d’objet se résume donc a ceci : sélectionner un constructeur dans le menu des
classes, I'exécuter et obtenir 'objet sur le présentoir.

Vous avez pu remarquer que la classe Person est étiquetée abstract (c’est une classe
abstraite). Vous noterez (si vous essayez) que vous ne pouvez pas créer d’objet de classe
abstraite (conformément aux spécifications du langage Java).

3.4 Exécution

Résumé : Pour exécuter une méthode, il suffit de la sélectionner dans le menu contextuel
de l’objet.

Une fois 'objet créé, vous pouvez exécuter ses opérations publiques (méthodes dans la
terminologie Java). Cliquez avec le bouton droit sur I'objet ; un menu contextuel apparait
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@ Uses I ﬁ
W Inheritance

= inherited from Object P
—  inherited from Person P |

String getRoom()
vaid setRoomiString)
String taString()

Inspect
Remove

F1G. 5 — Le menu objet.

B O a Blue): Method Result

5tring result = "(unknown room)" Inspect

Cet

& y

Fic. 6 — Affichage d'un résultat de fonction.

présentant les opérations (figure ff). Le menu énumere les méthodes applicables a cet objet
ainsi que deux opérations spéciales fournies par I'environnement (Inspect et Remove). Nous
en discuterons plus tard. Focalisons nous d’abord sur les méthodes.

Vous voyez qu’il existe deux méthodes : setRoom fixe et getRoom renvoie le numéro de
bureau pour ce membre de Staff. Essayez d’appeler getRoom. Sélectionnez tout simple-
ment cette méthode a partir du menu objet et elle sera exécutée. Une fenétre de dialogue
apparaitra montrant le résultat de 'appel (figure ). Dans ce cas, vous obtiendrez (unknown
room) parce qu’aucun nom de bureau n’a été donné pour cette personne.

Les méthodes héritées d'une superclasse sont disponibles grace a un sous-menu. En
téte du menu contextuel objet il y a deux sous-menus, un pour les méthodes héritées de
Object et un pour celles héritées de Person (figure ). Vous pouvez appeler les méthodes
de Person (telles que getName) en les sélectionnant dans le sous-menu. Essayez de le faire.
Vous constaterez que la réponse est également imprécise : " (unknown name)" s’affiche car
aucun nom de personne n’a été donné.

Maintenant, essayons de donner un numéro de bureau. Ceci permettra de voir comment
faire un appel avec parametres. Les appels a getRoom et getName ont des valeurs de retour,
mais aucun parametre. Appelez la fonction setRoom a partir du menu. Un parametre vous
est alors demandé dans une fenétre de dialogue (figure [7).
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a D : Blue): Method Call

A Set a new room number for this person.
void setRoomiString newRoom)

staff_1.setRoom (["M.3.18" D

Hk_’ f Cancel )

A

F1G. 7 — Dialogue d’appel de fonctions avec parametres.

En téte, on trouve linterface de la méthode a appeler (avec le commentaire et la si-
gnature). Ensuite, il y a une zone d’édition ol vous pouvez taper le(s) parametre(s). La
signature indiquée en haut précise qu'un parametre de type String est attendu. Entrez le
nom du nouveau bureau comme une chaine (entre des guillemets) dans le champ texte et
cliquez sur . C’est tout — puisque cette méthode ne renvoie pas de parametre, il n’y
a pas de fenétre de dialogue pour le résultat. Appelez de nouveau getRoom pour vérifier
que le bureau a effectivement changé. Exercez-vous a la création d’objets et a 'appel de
méthodes. Essayez d’appeler un constructeur avec arguments et appelez quelques méthodes
supplémentaires jusqu'a ce que vous soyez a 1’aise avec ces manipulations.

3.5 REdition d’une classe

Résumé :  Pour éditer le code source d’une classe, double-cliquer sur son icone.

Pour I'instant, nous n’avons considéré que l'interface des objets. Il est temps désormais
d’en voir le contenu. Vous pouvez voir I'implentation d’'une classe en sélectionnant Open
Editor a partir des opérations de classe. (Rappelez-vous : un clic droit sur une icone de classe
indique les opérations.) Un double clic gauche sur une icone de classe fait la méme chose.
L’éditeur n’est pas décrit completement dans ce tutoriel mais il devrait étre suffisamment
facile a utiliser. Des précisions sur ’éditeur seront fournies ultérieurement. Maintenant,
ouvrons l'implantation de la classe Staff. Trouvez l'implantation de la méthode getRoom.
Comme son nom le laisse deviner, elle renvoie le numéro de bureau du membre staff.
Changeons la méthode en ajoutant le préfixe "room" au résultat de la fonction (pour que
la méthode renvoie, par exemple, "room M.3.18" & la place de "M.3.18"). Nous pouvons
faire cela en modifiant la ligne
return room;
en
return "room " + room;

BLUEJ acceptant du Java standard, il n’y a aucune contrainte particuliere dans la fagon
d’implanter les classes.
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3.6 Compilation

Résumé :  Pour compiler une classe, cliquer sur le bouton de l’éditeur. Pour
compiler un projet, cliquer sur le bouton dans la fenétre projet.

Apres avoir modifié le texte (et avant de faire quoi que ce soit d’autre), ayez une vue
d’ensemble du projet (grace a la fenétre principale). Vous constaterez que l'icone de la classe
Staff a changé : elle est désormais hachurée. Cette apparence hachurée signale toutes les
classes qui n’ont pas été compilées depuis leur derniere modification. Revenons maintenant
a I’éditeur.

NB : Vous pouvez vous étonner de ne pas avoir trouvé de classes hachurées
lorsque vous avez ouvert ce projet pour la premiere fois. C’est tout simple-
ment parce que les classes du projet people ont été compilées avant leur dis-
tribution. Mais la plupart du temps, les projets de BLUEJ sont distribués non
compilés et, par conséquent, attendez-vous a trouver la plupart des icones
de classes hachurées lorsque vous ouvrirez pour la premiere fois un projet.

Dans la barre d’outils de ’éditeur on trouve plusieurs fonctions souvent utilisées. L’une

d’elles est . Cette fonction vous permet de compiler directement la classe en cours

d’édition. Appuyez maintenant sur le bouton . Si vous n’avez fait aucune erreur,
un message indiquant que la classe a été compilée doit apparaitre en bas de la fenétre
d’édition. Si vous avez fait une erreur de syntaxe, la ligne erronée apparait en surbrillance
et un message d’erreur s’affiche dans la zone information. (si la compilation marche du
premier coup, essayez d’introduire volontairement une erreur de syntaxe, par exemple en
omettant un point-virgule, pour voir comment elle est rapportée). Apres avoir compilé une
classe avec succes, fermez 1’éditeur.

NB : Il n’est pas nécessaire de sauver explicitement une classe. Le code
source d’une classe est en effet automatiquement sauvegardé quand c’est
utile (c’est-a-dire quand on ferme U'éditeur ou juste avant de compiler une
classe). Vous pouvez néanmoins sauver explicitement (il y a une fonction
pour cela dans le menu class de [’éditeur), mais cela ne se justifie que lorsque
votre systeme est instable, sujet a des réinitialisations fréquentes, et que
[’éventuelle perte de votre travail vous inquiéte.

La barre d’outils de la fenétre projet possede également un bouton . Cette
compilation entraine la compilation de tout le projet. (En fait, seules les classes modifiées
sont concernées et recompilées, dans le bon ordre.) Essayez ceci en modifiant une ou deux
classes (de sorte qu’au moins deux classes hachurées apparaissent dans le diagramme de
classes) puis cliquez sur le bouton | Compile |. Si une erreur est détectée dans I'une des classes
compilées, I’éditeur s’ouvre et indique 'emplacement et la nature de I'erreur. Vous pourrez
constater que le présentoir a objet est a nouveau vide. Les objets sont en effet retirés apres
tout changement d’implantation.
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super(" (unknown namel)", 00007} ;
room = "{unknown room)';

[4]

F |:-:-:-: 5;5;|
interface expected here H
-

L

58 ved

F1Gc. 8 — Une erreur de compilation et le bouton d’aide.

3.7 Aide pour les erreurs de compilation

Résumé : Pour obtenir de l'aide au sujet d’une erreur de compilation, cliquer sur le
point d’interrogation situé a prorimité du message d’erreur.

Tres fréquemment, les étudiants débutants ont des difficultés avec les messages en-
gendrés par le compilateur. Nous essayons d’apporter une aide.

Ouvrez a nouveau I’éditeur, introduisez une erreur dans le code source, puis compilez.
Un message d’erreur doit apparaitre dans la zone d’information de I'éditeur. A I'extrémité
droite de cette zone d’information il y a un point d’interrogation sur lequel vous pouvez
cliquer pour obtenir des précisions sur la nature de Uerreur (figure §).

Au stade actuel de développement de BLUEJ, tous les messages d’erreur n’ont pas
un texte d’aide associé. Certains restent a écrire, mais de nombreuses erreurs sont déja
explicitées. Les autres seront décrites et incluses dans une future distribution de BLUEJ.
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BlueJ: Object Inspector of class Staff ) [=1 =1

Object of class Staff

Ktatic Tields

O bject fields

private Ltring rogm = "M.3.18"

private String name = "Buzz Lightyear"
private int yearOfBirth = 1982

L N

Fi1G. 9 — La fenétre d’inspection

4 Pour aller un peu plus loin...

Dans cette section, nous allons voir quelques possibilités supplémentaires de 'envi-
ronnement. Méme si ces possibilités ne sont pas essentielles, elles sont tres fréquemment
utilisées.

4.1 Inspection

Résumé :  L7inspection d’objet permet un débogage simple en montrant [’état interne
d’un objet.

Quand vous avez exécuté une méthode d’un objet, vous avez peut-étre remarqué 1’opé-
ration Inspect qui est disponible sur les objets en plus des méthodes définies par 'utilisateur
(figure ). Cette opération permet de vérifier 'état des variables d’instance (les champs)
des objets. Essayez de créer un objet avec une valeur quelconque (par exemple, un objet
Staff avec le constructeur qui prend des parametres). Ensuite, sélectionnez Inspect depuis
le menu de l'objet. Une fenétre apparait ; elle affiche les champs de 'objet, leur type et
leur valeur (figure ).

L’inspection est utile pour vérifier rapidement si une méthode modifiant 1’état d’un ob-
jet s’est exécutée correctement. L’'inspection est également un outil simple pour le débogage.

Dans l'exemple Staff, tous les champs ont des types simples (soit des types scalaires
primitifs, soit des chaines de caracteres). La valeur de ces types est affichée directement.
Vous pouvez immédiatement voir si le constructeur a réalisé les bonnes affectations.

Pour des classes plus compliquées, la valeur des champs peut étre une référence vers un
autre objet défini par I'utilisateur. Nous allons utiliser un autre projet pour illustrer ce cas.
Ouvrez le projet people2 qui est aussi inclus dans la distribution BLUEJ. Le présentoir de
people2 est donné par la figure [[J. Comme vous pouvez le voir, ce deuxieme exemple a
une classe Address en plus des classes vues précédemment. L’un des champs de la classe
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—-i Elue): peopleZ |- |_||
Project Edit Tools VYiew Help

Mew Class

> |

Compile !
I ==abstract==
b —=| Person

Address

Database

W ie
v Uses Staff Student

[¥] Inheritance

] Creating ohject... Done

Fic. 10 — La fenétre du projet people2

Person est du type Address, type défini par I'utilisateur.

Pour tester I'inspection avec des champs contenant des objets, créez un objet Staff et
exécutez la méthode setAddress de cet objet (vous la trouverez dans le sous-menu Person).
Entrez une adresse. En interne, le code de Staff crée un objet de la classe Address et le
stocke dans son champ address.

Maintenant, inspectez l'objet Staff. Le résultat de cette inspection est la fenétre de la
figure [[1. Les champs de 'objet Staff incluent maintenant I’adresse. Comme vous pouvez
le constater, sa valeur est affichée comme "<object reference>" (référence d’'un objet);
parce que c’est un type complexe, défini par 'utilisateur, sa valeur ne peut pas étre af-
fichée directement dans la liste. Pour examiner la représentation de cet objet Address,
sélectionnez le champ address dans la liste et cliquez le bouton W dans la fenétre.
(Vous pouvez également double-cliquer sur le champ address). Une nouvelle fenétre d’ins-
pection est ouverte, elle montre la représentation de I'objet Address (figure [[J).

Si le champ sélectionné est public alors, au lieu de cliquer , vous pouvez aussi

sélectionner le champ address et cliquer le bouton . Cette opération place 1’ob-
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Elug]: Object Inspector of class 5t

Ohkject of class Staff

Static fields

Inspect

Object fields

private String room="mM.3.18"

private String narne = "Buzz Lightyear"
private intyearQfBinh = 1932

private Address address = =object reference=

Close

F1G. 11 — Inspection avec une référence sur un objet

—|  Blue): Object Inspector of class Staff

a

m

Static fields

Object fields
private String roorm =
private String narme
private intyearofgirt
private Address add

Object of class Staff

Object of class Address

Static fields

Ohject fields

private String street="3 Baillie Court"
private String town = "Frankston”
private String postCode ="3199"
private String country =™

Close

F1G. 12 — Inspection de 1’état interne d’un objet
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jet sélectionné sur le présentoir a objets. Vous pouvez alors 'examiner en exécutant ses
méthodes.

4.2 Passage d’objets en parametre

Résumé : Un objet peut étre passé en parametre lors d’un appel de méthode en cliquant
SUr son icone.

Les objets peuvent étre passés en parametre de méthodes d’autres objets. Essayons sur
un exemple. Créez un objet de la classe Database. (Vous noterez que la classe Database
possede un seul constructeur qui n’a pas de parametre, aussi la construction d’un objet est
directe.) L’objet Database permet de stocker une liste de personnes. Il a des méthodes pour
ajouter une personne et pour afficher toutes les personnes actuellement stockées. (L’appeler
Database, c’est-a-dire base de données, est quelque peu exagéré!)

Si vous n’avez pas déja un objet Staff ou Student sur le présentoir a objets, créez
I'un ou 'autre. Pour la suite, vous avez besoin d’avoir en méme temps sur le présentoir un
objet Database, et soit un objet Staff, soit un objet Student.

Maintenant, exécutez la méthode addPerson sur 1'objet Database. (Rappel : la classe
Person est abstraite, aussi il n’y a pas d’objet qui soit directement du type Person. Mais,
grace au sous-typage, des objets Student et Staff peuvent étre substitués a des objets
Person. Ainsi, il est autorisé de passer un Student ou un Staff la ou un objet Person
est attendu.) Pour passer un objet du présentoir en tant que parametre lors de appel
que vous étes en train de faire, vous pouvez saisir son nom dans le champ parametre ou,
en guise de raccourci, simplement cliquez sur 'objet. Ceci entre son nom dans la zone de
saisie de 'appel de méthode. Cliquez et l'appel est effectué. Puisqu’il n’y a pas de
valeur de retour pour cette méthode, le résultat n’est pas visible immédiatement. Vous
pouvez exécuter la méthode 1istAll sur 'objet Database pour vérifier que 'opération a
réellement été exécutée. La méthode 1istAll affiche les informations de la personne sur la
sortie standard. Nous remarquerez que le terminal s’ouvre automatiquement pour afficher
le texte.

Essayez ceci de nouveau avec plusieurs personnes entrées dans la « base de données ».
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5 Création d’un nouveau projet

Ce chapitre expliquera rapidement comment créer un nouveau projet.

5.1 Création du répertoire de projet

Résumé :  Pour créer un projet, choisir New dans le menu Project.

Pour créer un nouveau projet, choisissez Project > New du menu. Une boite de sélection
s’ouvre et vous permet de spécifier le nom et I'emplacement du nouveau projet. Essayez.
Vous pouvez choisir un nom quelconque pour votre projet. Apres avoir cliqué , un
répertoire qui porte le nom choisi sera créé, et la fenétre principale montrera le nouveau
projet vide.

5.2 Création des classes

Résumé : Pour créer une classe, cliquer le bouton | New Class| et spécifier un nom.
Vous pouvez maintenant créer vos classes en cliquant le bouton | New Class| de la barre

d’outils du projet. Il vous sera demandé de fournir un nom pour la classe — ce nom doit
étre un identificateur Java valide. Vous pouvez aussi choisir parmi quatre types de classes :
abstract, interface, applet ou « standard ». Le choix détermine quel squelette sera
créé pour la classe. Vous pouvez changer le type de classe plus tard en modifiant le code
source (par exemple, en ajoutant le mot-clé abstract dans le code). Apres avoir créé une
classe, celle-ci est représentée par une icone dans le diagramme. Si ce n’est pas une classe
standard, le type (interface, abstract, ou applet) est indiqué par une icone. Quand
vous ouvrez ’éditeur pour une nouvelle classe il affiche le squelette par défaut qui a été
créé pour votre classe — ceci vous permettra de démarrer facilement 1’écriture du code.
Le code par défaut est syntaxiquement correct. Il peut étre compilé (mais ne fait rien de
significatif). Essayez de créer plusieurs classes et de les compiler.

5.3 Création des dépendances

Résumé :  Pour créer une fleche, cliquer le bouton correspondant et faire glisser la
fleche sur le diagramme, ou tout simplement modifier le code dans [’éditeur. Le diagramme
de classe montre les dépendances entre les classes sous la forme de fleches.

Les relations d’héritage (extends ou implements) sont représentées comme des fleches
doubles et les relations uses comme des fleches simples. Vous pouvez ajouter des dépendances
soit graphiquement (directement sur le diagramme) ou textuellement dans le code source. Si
vous ajoutez une fleche graphique, le source est automatiquement mis a jour ; inversement,
si vous ajoutez une dépendance dans le source, le diagramme est mis a jour.

Pour ajouter la fleche de maniere graphique, cliquez sur le bouton approprié (double
fleche pour extends ou implements, simple fleche pour uses) et faites glisser la fleche d’une
classe vers l'autre.



5 CREATION D’UN NOUVEAU PROJET 19

L’ajout d’une fleche d’héritage provoque I'insertion d’une définition extends ou implements

dans le code source de la classe (suivant que la cible est une classe ou une interface).

Ajouter une fleche uses ne modifie pas immédiatement le code (sauf dans le cas ou la
classe provient d’'un autre paquetage, dans ce cas une déclaration import est engendrée,
mais nous ne I’avons pas encore vu dans nos exemples). Avoir dans le diagramme une fleche
uses qui pointe vers une classe qui n’est pas effectivement utilisée dans son code source va
générer plus tard un avertissement qui indique qu’une relation uses a été déclarée, mais la
classe n’a pas été utilisée.

Ajouter une fleche de maniere textuelle est facile : tapez simplement le code nécessaire.
Des que le fichier de la classe est enregistré, le diagramme est mis a jour. (Et souvenez-vous
que la fermeture de 'éditeur réalise un enregistrement automatique).

5.4 Suppression d’éléments

Résumé :  Pour supprimer une classe, choisir la fonction Remove du menu contextuel.
Pour supprimer une fleche, choisir Remove du menu Edit et cliquer sur la fléeche.

Pour supprimer une classe du diagramme, sélectionnez la classe et ensuite Remove class
du menu Edit. Vous pouvez aussi sélectionner Remove du menu contextuel de la classe.
Pour supprimer une fleche, sélectionnez Remove Arrow du menu et ensuite sélectionnez la
fleche que vous voulez supprimer.
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public int loopiint count)
{

int sum = 17:

for (int i=0; i<count; i++) {
@ sum = sum + i;

sum = sum - Z:
}

return Jum;

Fi1G. 13 — Un point d’arrét

6 Mise au point

Ce chapitre présente les aspects essentiels de 'outil de mise au point de programmes
(debugging) offert par BLUEJ. En général, les enseignants en programmation considerent
que 'utilisation de ce type d’outil des I'initiation a la programmation est utile, mais qu’ils ne
disposent pas de suffisamment de temps pour présenter un outil compliqué supplémentaire.

L’outil de mise au point doit donc étre aussi simple que possible. L’objectif choisi dans
le cadre de BLUEJ était que l'outil puisse étre présenté en 15 minutes et qu’il puisse étre
utilisé par les étudiants sans informations supplémentaires. A vous de juger si cet objectif
a ¢été atteint.

Les fonctionnalités traditionnelles des outils de mise au point ont donc été réduites aux
taches suivantes :

— positionnement de points d’arrét ;

— exécution pas a pas du programme;

— consultation du contenu des variables.

Pour commencer, ouvrez le projet debugdemo qui est dans le répertoire d’exemples
de la distribution. Ce projet contient quelques classes dont 1’objectif est uniquement la
présentation des fonctionnalités de I'outil — elles n’ont pas de sens en dehors de cet objectif.

6.1 Positionnement de points d’arrét

Résumé :  Pour positionner un point d’arrét, cliquer sur la zone des points d’arrét a
gauche du texte dans l’éditeur (voir figure [13).

Le positionnement d’un point d’arrét permet d’interrompre l'exécution a un endroit
précis du programme.

Dans I'éditeur, la zone des points d’arrét se trouve a gauche du texte (voir figure [3)”.
Vous pouvez positionner un point d’arrét en cliquant dans cette zone. Un panneau « stop »
apparait alors pour indiquer la position du point d’arrét.

Essayez ceci. Ouvrez la classe Demo, recherchez la méthode loop, positionnez un point
d’arrét dans la boucle for. Le panneau « stop » doit apparaitre dans votre éditeur.

L’exécution s’arréte lorsqu'une ligne de code a laquelle est attaché un point d’arrét est
atteinte.
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F1G. 14 — Fenétre de mise au point

Essayez ceci : créez un objet de la classe Demo puis appelez la méthode loop avec un
parametre de valeur 10 par exemple. Dés que le point d’arrét est atteint, la fenétre d’édition
contenant la ligne courante apparait, suivie par la fenétre de mise au point. Celle-ci est
semblable a la figure [[4.

La ligne qui doit étre exécutée par la suite est mise en évidence dans I’éditeur (en vidéo
inverse). L’exécution a été arrétée juste avant cette ligne.

6.2 Exécution pas a pas

Résumé : Pour exécuter un programme ligne par ligne, utiliser les boutons et

de l'outil de mise au point.

Lorsque 'exécution est interrompue (ce qui confirme que la méthode a réellement été
exécutée et que ce point du code a réellement été atteint), vous pouvez exécuter le pro-
gramme pas a pas et suivre le déroulement de I’exécution. Pour cela, cliquez plusieurs fois
sur le bouton dans la fenétre de mise au point. Vous remarquerez que la ligne du
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programme mise en évidence dans I'éditeur change (la ligne en vidéo inverse se déplace au
fur et & mesure de 'exécution). A chaque fois que vous cliquez sur le bouton , une
seule ligne de code est exécutée puis 'exécution s’interrompt de nouveau.

Essayons sur une autre méthode. Positionnez un point d’arrét dans la méthode carTest ()
de la classe Demo sur la ligne contenant places = myCar.seats() ;.

Appelez cette méthode. Quand le point d’arrét est atteint, le systeme est prét a exécuter
la ligne contenant ’appel a la méthode seats () de la classe Car. En cliquant sur le bouton
, I'ensemble de la ligne est exécutée (sans détailler les instructions composant la

méthode). Essayons maintenant le bouton |Step Into| Celui-ci permet d’exécuter le corps

de la méthode pas a pas (et non en un seul pas comme précédemment). Dans ce cas, vous
étes « transporté » dans la méthode seats() de la classe Car. Vous pouvez maintenant
progresser ligne par ligne jusqu’a la fin de la méthode et retourner a la ligne appelante.
Notez comment 1'outil de mise au point affiche les changements.

Les commandes ‘Step et ‘Step Into‘ se comportent de la méme maniere si la ligne
courante ne contient pas d’appels de méthodes.

6.3 Inspection des variables

Résumé : L’acces au contenu des variables est extrémement simple — il est affiché
automatiquement par 'outil de mise au point.

Lors de la mise au point de vos programmes, il est essentiel de pouvoir accéder au
contenu des objets (les parametres et variables locales des méthodes ou bien dans les
attributs d’instances et de classes).

Cela se fait tres simplement — vous avez déja étudié la plupart des mécanismes nécessaires.
Vous n’avez pas a utiliser de commandes spécifiques : la valeur des attributs de classe et
d’instance de I'objet courant et des parametres et variables locales de la méthode courante
sont toujours affichés et mis a jour systématiquement.

Vous pouvez choisir des méthodes dans la séquence des appels pour afficher les contenus
des attributs et variables des autres objets actifs et méthodes. Par exemple, positionnez un
autre point d’arrét dans la méthode carTest () puis lancez ’exécution. La séquence d’appel
est affichée a la gauche de l'outil de mise au point. Il affiche actuellement : Car.seats
Demo.carTest.

Cela signifie que la méthode Car.seats a été appelée par la méthode Demo.carTest.
Vous pouvez sélectionner la méthode Demo . carTest dans cette liste pour consulter le source
de cette méthode et afficher le contenu actuel de ses variables.

Avancez apres la ligne qui contient 'instruction new Car (). Notez que la valeur de la
variable locale myCar est étiquetée en tant que <object reference>. Toutes les instances
de classes (sauf pour la classe String) sont affichées ainsi. Affichez le contenu de 'instance
en double-cliquant sur la variable associée. Cela fait apparaitre la fenétre d’inspection du
contenu d’'un objet qui a déja été décrite précédemment (voir chapitre 4). Il n’y a aucune
différence réelle entre ’acces au contenu des objets dans ce contexte et ’acces au contenu
des objets via le présentoir a objets.



6 MISE AU POINT 23

6.4 Arrét et fin

Résumé : Les boutons‘ Ha/t‘ et‘ Terminate‘ peuvent étre utilisés pour arréter ’'exécution
temporairement ou définitivement.

L’exécution d’un programme peut étre tres longue, suffisamment pour que se pose
la question d’un fonctionnement correct extrémement long ou d’un calcul infini. Il est
possible d’obtenir une réponse simplement. Appelez la méthode longloop() de la classe
Demo. Celle-ci a un temps d’exécution relativement long.

Ouvrez la fenétre de mise au point si elle n’est pas déja affichée (cliquer sur le symbole en
rotation qui indique que la machine est active durant I’exécution permet de faire apparaitre
I'outil de mise au point).

Cliquez ensuite sur le bouton . L’exécution est interrompue exactement comme
si elle avait atteint un point d’arréet. Il est maintenant possible d’exécuter quelques pas,
de consulter la valeur des variables pour s’assurer que tout se déroule correctement et
qu’il ne manque que du temps pour que le calcul se termine. Vous pouvez poursuivre
le calcul (bouton ) puis Iarréter de nouveau (bouton ) et ceci plusieurs
fois pour mesurer la vitesse du calcul. Si vous ne souhaitez pas poursuivre le calcul (par
exemple, apres avoir découvert qu’il s’agit vraiment d’une boucle infinie) vous pouvez
cliquer sur le bouton pour arréter définitivement ’exécution. Cette fonction ne
doit etre utilisée que dans des cas extréemes car des objets peuvent se retrouver dans un
état incohérent suite a l'interruption en cours d’exécution d’une méthode.
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F1c. 15 — La boite de dialogue Export

7 Création d’applications autonomes

Résumé : Pour créer une application autonome, utiliser Project > Export...

BLUEJ peut créer des fichiers/archives jar exécutables. Un fichier jar exécutable peut
étre exécuté en double-cliquant sur le fichier (sur certains systémes, par exemple Windows
et MacOS X), ou en utilisant la commande en ligne java -jar <file-name>.jar (invite
Unix ou DOS). Essayons cela sur le projet exemple hello. Ouvrez le projet (il est dans le
répertoire examples). Assurez-vous que le projet est compilé. Choisissez la fonction Export
du menu Project. Une boite de dialogue apparait ot vous indiquez le format de sauvegarde
(figure [[§). Choisissez jar file pour créer un fichier jar exécutable. Pour rendre exécutable
le fichier jar, vous devez aussi indiquer une classe principale. Cette classe doit définir une
méthode main valide (avec la signature public static void main(String[] args)).

Dans notre exemple, le choix de la classe principale est facile : il n’y a qu’une seule classe.
Choisissez Hello dans le menu contextuel. Si vous avez d’autres projets, choisissez la classe
qui contient la méthode main que vous voulez exécuter. Généralement, on n’inclut pas les
sources dans les fichiers exécutables, mais cela est possible, si vous souhaitez distribuer aussi
vos sources. Cliquez sur . Ensuite, vous avez une boite de dialogue pour saisir le

nom du fichier jar que vous voulez créer. Tapez hello et cliquez sur . La création
du fichier jar exécutable est terminée. Si I’application utilise une interface graphique, vous
pouvez double-cliquer sur le fichier jar. Comme I’exemple utilise une interface textuelle, il
doit étre lancé depuis la fenétre d’un terminal. Ouvrez un terminal ou une fenétre DOS.
Allez dans le répertoire ou le fichier jar a été sauvé (vous devez voir un fichier hello. jar).
En supposant que Java est correctement installé sur votre systeme, vous pouvez démarrer
le fichier jar en tapant java -jar hello. jar.
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F1G. 16 — La fenétre de saisie Run Applet

8 Création d’appliquettes

8.1 Exécution d’une appliquette

Résumé : Pour exécuter une appliquette, choisir Run Applet dans le menu contextuel
de appliquette.

BLUEJ permet de créer et d’exécuter aussi bien des appliquettes que des applications.
Nous avons inclus une appliquette dans le répertoire d’exemples de la distribution. Tout
d’abord, nous allons tenter d’exécuter une appliquette. Ouvrez le projet appletdemo des
exemples.

Vous constaterez que ce projet ne possede qu’une unique classe appelée CaseConverter.
L’icone de la classe est celui d’'une appliquette (avec 1’étiquette <<applet>>). Apres avoir
compilé, sélectionnez la commande Run Applet du menu contextuel de la classe. Une fenétre
de saisie s’ouvre vous permettant d’effectuer certains choix (Figure [[G).

Vous pouvez alors choisir d’exécuter 'appliquette dans un navigateur ou dans un visua-
lisateur d’appliquettes (ou seulement de générer la page web sans 'exécuter). Conservez
la configuration par défaut et cliquez sur . Apres quelques secondes, un visualisateur
d’appliquettes devrait s’ouvrir en affichant ’appliquette CaseConverter.

Le visualisateur d’appliquettes est installé avec votre JDK ce qui assure d’avoir toujours
la méme version que celle de votre compilateur Java. Vous rencontrerez ainsi généralement
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moins de problemes avec lui que lors de 'exécution dans des navigateurs. Votre navigateur
peut exécuter une version différente de Java et selon la version de ce navigateur, cela peut
poser des problemes. Cela devrait cependant fonctionner avec la plupart des navigateurs
habituels.

Sous les systemes Windows et MacOS, BLUEJ utilise le navigateur défini comme navi-
gateur par défaut. Sous Unix, le navigateur est spécifié dans le fichier de configuration de
BLUEJ.

8.2 Création d’une appliquette

Résumé : Pour créer une appliquette, cliquer sur le bouton et choisir
Applet| comme type de classe.

Apres avoir examiné comment exécuter une appliquette, nous allons maintenant en
créer une.

Créez une nouvelle classe de type Applet (vous pouvez sélectionner le type dans le
choix ) Compilez puis exécutez 'appliquette. C’est gagné! Ce n’était pas trop
dur?

Les appliquettes (comme les autres classes) sont générées avec un squelette de classe par
défaut contenant du code valide. En ce qui concerne les appliquettes, ce code montre une
appliquette simpliste affichant deux lignes de texte. Vous pouvez ensuite ouvrir I’éditeur
pour insérer votre propre code dans celui de ’appliquette.

Vous y trouverez toutes les méthodes classiques des appliquettes avec un commentaire
les caractérisant. Le code exemple est dans la méthode paint.

8.3 Test d’une appliquette

Dans certains cas, il peut étre utile de créer un objet Applet dans le présentoir a
objets (comme pour les classes normales). BLUEJ offre cette possibilité — le constructeur
est présenté dans le menu contextuel des appliquettes. A partir du présentoir, vous ne
pouvez pas exécuter l'appliquette complete mais seulement appeler certaines méthodes.
Cela peut étre utile pour tester des méthodes seules que vous avez écrites comme une
partie de 'implantation de votre appliquette.



9 AUTRES OPERATIONS 27

9 Autres opérations

9.1 Ouverture de paquetages extérieurs a BluelJ

Résumé : Les paquetages extérieurs a BLUEJ peuvent étre ouverts avec la commande
Project > Open Non Bluej

BLUEJ vous permet d’ouvrir des paquetages existants créés a 'extérieur de BLUEJ.
Pour faire ceci, sélectionnez Projet > Open Non BlueJ a partir du menu. Sélectionnez le
répertoire qui contient les fichiers source Java, et cliquez sur le bouton | Open in Bluel |. Le
systeme vous demandera de confirmer que vous voulez ouvrir ce répertoire.

9.2 Ajout de classes existantes au projet

Résumé : Des classes venant de [extérieur peuvent étre copiées dans le projet en
utilisant la commande Add Class from File.

Souvent, vous devez utiliser une classe que vous avez récupérée a un autre endroit dans
votre projet BLUEJ. Par exemple, un enseignant peut donner une classe Java aux étudiants
pour qu’ils 'utilisent dans un projet. Vous pouvez inclure facilement une classe existante
dans votre projet en sélectionnant Edit > Add Class from File... & partir du menu. Ceci vous
permettra de sélectionner un fichier source Java (i.e. avec l'extension . java) a importer.

Quand la classe est importée dans le projet, elle est copiée et enregistrée dans le
répertoire du projet courant. L’effet est exactement le méme que si vous aviez créé la
classe et écrit tout son code source.

Une autre possibilité est d’ajouter le fichier source de la nouvelle classe au répertoire du
projet a l'extérieur de BLUEJ. Ala prochaine ouverture du projet, la classe sera intégrée
dans le diagramme du projet.

9.3 Appel de main et d’autres méthodes statiques

Résumé : Les méthodes statiques peuvent étre appelées depuis le menu contextuel de la
classe.

Ouvrez le projet hello du répertoire d’exemples. La seule classe du projet (la classe
Hello) définit la méthode standard main.

En cliquant avec le bouton droit sur la classe, vous voyez que le menu inclut non
seulement le constructeur de la classe, mais aussi la méthode de classe (statique) main.
Vous pouvez appeler main directement depuis le menu (sans créer l'objet au préalable,
comme ce serait le cas pour une méthode d’instance (non-statique)).

Toutes les méthodes statiques peuvent étre appelées de cette maniere. La méthode
main attend un tableau de chaines de caracteres comme argument. Vous pouvez définir un
tableau de chaines avec la syntaxe Java standard pour les constantes. Par exemple, vous
pouvez passer {"un", "deux", "trois" } (sans oublier les accolades) a la méthode.
Essayez-donc...
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NB : En Java standard, les tableaux constants ne peuvent pas étre utilisés
directement comme arguments pour un appel de méthode. Ils servent seule-
ment comme valeurs initiales. En BLUEJ, pour que ce genre d’appel soit
possible, les tableaur constants en parameétre sont possibles.

9.4 Génération de la documentation

Résumé : Pour engendrer la documentation d’un projet, sélectionner Project Documen-
tation depuis le menu Tools.

Vous pouvez engendrer la documentation de votre projet dans le format Javadoc stan-
dard depuis BLUEJ. Pour faire ceci, sélectionnez Tools > Project documentation depuis le
menu. Cette fonction engendre la documentation pour toutes les classes d’un projet depuis
le code source de la classe, et ouvre un navigateur pour l’afficher.

Vous pouvez aussi engendrer et visualiser la documentation d’une classe donnée direc-
tement dans 1’éditeur BLUEJ. Pour faire ceci, ouvrez I'éditeur et utilisez le menu dans la
barre d’outils de I’éditeur. Sélectionnez Interface au lieu de Implementation. Ceci affiche la
documentation en javadoc (de 'interface de la classe) dans 1'éditeur.

9.5 Travail avec les bibliotheques

Résumé : Les classes standard de I’API Java peuvent étre visualisées en sélectionnant
Help > Java Class Libraries

Souvent, quand vous écrivez un programme Java, vous devez faire référence aux bi-
bliotheques standard Java. Vous pouvez ouvrir un navigateur affichant la documentation
de 'API du JDK en sélectionnant Help > Java Standard Classes depuis le menu (si vous
étes connecté a Internet).

La documentation du JDK peut aussi étre installée et utilisée localement (hors-ligne).
La section d’aide du site de BLUEJ explique comment faire.

9.6 Création d’objets a partir des classes de ’API

Résumé :  Pour créer des objets a partir de classes d’une bibliotheque, sélectionner
Tools > Use Library Class

BLUEJ propose une fonction pour créer des instances de classes qui ne font pas partie
de votre projet, mais sont définies dans la bibliotheque. Vous pouvez, par exemple, créer
des objets de classe String ou ArrayList. Ceci peut étre utile pour tester rapidement ces
objets.

Vous pouvez créer un objet de la bibliotheque en sélectionnant Tools > Use Library
Class... depuis le menu. Une boite de dialogue apparaitra pour vous demander un nom
de classe complet, comme java.lang.String (vous devez obligatoirement mettre le nom
complet, c’est-a-dire comprenant le nom des paquetages englobants).

Le menu associé au champ de saisie de texte comprend les classes utilisées récemment.
Quand vous avez saisi le nom d’une classe, appuyez sur Entrée pour afficher tous ses
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constructeurs et ses méthodes de classe (statiques) dans une liste. Toutes ces méthodes
peuvent étre invoquées en les sélectionnant dans la liste.
L’invocation se fait de la méme maniere que pour tout autre constructeur ou méthode.
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10 En guise de résumé

Pour débuter — édition / compilation / exécution
1. Pour ouvrir un projet, sélectionner Open dans le menu Project.
2. Pour créer un objet, sélectionner un constructeur dans le menu contextuel de la classe.
3. Pour exécuter une méthode, il suffit de la sélectionner dans le menu contextuel de
I'objet.
4. Pour éditer le code source d'une classe, double-cliquer sur son icone.
5. Pour compiler une classe, cliquer sur le bouton de I’éditeur. Pour compiler

un projet, cliquer sur le bouton dans la fenétre projet.

6. Pour obtenir de ’aide au sujet d'une erreur de compilation, cliquer sur le point d’in-
terrogation situé a proximité du message d’erreur.

Pour aller un peu plus loin...
7. L’inspection d’objet permet un débogage simple en montrant 1’état interne d’un objet.

8. Un objet peut étre passé en parametre lors d'un appel de méthode en cliquant sur
son icone.

Création d’un nouveau projet
9. Pour créer un projet, choisir New dans le menu Project.

10. Pour créer une classe, cliquer le bouton | New Class| et spécifier un nom.

11. Pour créer une fleche, cliquer le bouton correspondant et faire glisser la fleche sur
le diagramme, ou tout simplement modifier le code dans I’éditeur. Le diagramme de
classe montre les dépendances entre les classes sous la forme de fleches.

12. Pour supprimer une classe, choisir la fonction Remove du menu contextuel. Pour sup-
primer une fleche, choisir Remove du menu Edit et cliquer sur la fleche.

Mise au point

13. Pour positionner un point d’arrét, cliquer sur la zone des points d’arrét a gauche du
texte dans I’éditeur (voir figure [[3).

14. Pour exécuter un programme ligne par ligne, utiliser les boutons ‘ Step‘ et ‘ Step Into
de l'outil de mise au point.

15. L’acces au contenu des variables est extremement simple — il est affiché automatique-
ment par l'outil de mise au point.

16. Les boutons |Halt] et | Terminate| peuvent étre utilisés pour arréter exécution tem-
porairement ou définitivement.

Création d’applications autonomes
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17. Pour créer une application autonome, utiliser Project > Export...

Création d’appliquettes

18. Pour exécuter une appliquette, choisir Run Applet dans le menu contextuel de I’ap-
pliquette.

19. Pour créer une appliquette, cliquer sur le bouton et choisir | Applet | comme

type de classe.

Autres opérations

20. Les paquetages extérieurs a BLUEJ peuvent étre ouverts avec la commande Project
> Open Non Bluej

21. Des classes venant de 'extérieur peuvent étre copiées dans le projet en utilisant la
commande Add Class from File.

22. Les méthodes statiques peuvent etre appelées depuis le menu contextuel de la classe.

23. Pour engendrer la documentation d'un projet, sélectionner Project Documentation
depuis le menu Tools.

24. Les classes standard de ’API Java peuvent étre visualisées en sélectionnant Help >
Java Class Libraries

25. Pour créer des objets a partir de classes d’une bibliotheque, sélectionner Tools > Use
Library Class
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